
Knockaround 

 

Basado en el capítulo 2 del libro Unity Virtual Reality Projects (2015) escrito por Jonathan 

Linowes, en el capítulo 4 del libro Getting Started with unity 5 (2015) escrito por el Dr. 

Edward Lavieri y en el capítulo 6 del libro Blender 3D – Architecture, Buildings and 

Scenery (2008) escrito por Allan Brito. 

 

Chapter 1. The Diorama. 

1.- Añadir un plano a la escena y llamarlo “Ground Plane” con posición (0, 0, 0). 

2.- Crear un cubo en posición (0, 0.5, 0) y rotación (0, 20, 0). Y una esfera en posición (1.6, 

0.75, -1.75). Crear una carpeta de “Materials” dentro de Assets en la vista de proyectos. 

Crear dos materiales llamados “Red” y “Blue” con los colores correspondientes y 

aplicárselos a la esfera y al cubo respectivamente. 

3.- Añadir otro plano llamado “Photo Plane”. Rotarlo -90 grados en Z. Rotarlo 90 grados en 

Y de forma que quede mirando hacia la cámara. Moverlo al fondo del plano de tierra y 

sobre él (posición Z=5 e Y=5). 

4.- Crear en Assets (en la vista de proyecto) una carpeta llamada “Textures”. Seleccionar la 

foto “Grand Canyon.jpg” que se incluye como recurso en la práctica (u otra foto que 

tengamos disponible) y arrastrarla sobre la nueva carpeta. Una vez en la vista de 

proyectos, arrastrar la imagen sobre el plano “Photo Plane” en la escena. 

5.- Girar el plano “Photo Plane” 90 grados en X. Escalarlo en Z (eje en coordenadas locales) 

a 0.75 para conservar el factor de forma con respecto a las dimensiones iniciales de la 

imagen (es el cociente de su anchura entre su altura original). Cambiar su posición en Y a 

3.75 para que quede apoyado en el plano de tierra. 

6.- Seleccionar el objeto “Photo Plane” y en el componente “Texture” dentro del Inspector 

cambiar su “Shader” de “Standard” a “Unlit | Texture”. 

7.- Crear un nuevo material en la carpeta “Materials” de la vista de proyecto. Llamarlo 

“Ground”. Arrastrarlo sobre el plano “Ground Plane”. Con el selector de color de “Albedo” 

en el material, ir a la imagen y seleccionar un marrón oscuro de los presentes en la base. 

Chapter 2. Measuring. 

8.- Crear un nuevo cubo. Será un cubo unitario de referencia. Llamarlo “Unit Cube” y 

ubicarlo en la posición (-3, 0.5, -2). Una vez construido, podemos desmarcar el check junto 

a su nombre en el inspector y lo reservamos para poder medir después magnitudes. 

9.- Cargar el paquete de efectos con el menú Assets>Import package>Effects. Localizar el 

prefabricado en Assets/Standard Assets/Effects/Projectors/Prefabs> Grid Projector y 

arrastrarlo a la escena. Posición (-2.5, 5, -0.5) Rotación (90, 0, 0). 

10.- Probar a cambiar el shader al proyector a “Projector/Multiply”. Probar a cambiar su 

“Orthographic Size” a 0.5. Desactivar el grid por defecto con la opción “Show Grid” del 

desplegable “Gizmos” en la parte superior de la vista de escena. 



Chapter 3. The Spider. 

11.- Cargar el paquete de efectos con el menú Assets>Import package>Characters. 

Localizar el prefabricado en Assets/Standard Assets/Characters/ ThirdPersonCharacter/ 

Prefabs> ThirdPersonController y arrastrarlo a la escena. Posición (-3, 0, -2) Rotación Y 180. 

12.- Ejecutamos la escena. Con la tecla SHIFT pulsada y las teclas cursoras caminamos. Sin 

la tecla SHIFT corremos. Con SPACE saltamos. 

13.- Creamos una carpeta en Assets llamada “Girl” y arrastramos en ella los archivos 

contenidos en la carpeta “Girl” de los recursos de la práctica. Proceden de 

(http://tf3dm.com/3d-model/puo-37663.html). Arrastramos el prefabricado Girl de la vista 

de proyectos a la escena. La ubicamos en x = -3 y z = -2 al igual que Ethan. 

14.- Seleccionando el modelo Girl en la vista de proyectos le cambiamos la escala a 1.75 y 

pulsamos aplicar (para que coincida con el tamaño de Ethan). 

15.- En la vista de jerarquía borramos “EthanBody”, “EthanGlasses” y “EthanSkeleton” que 

cuelgan de ThirdPersonController y después arrastramos el objeto “Girl” desde la vista de 

jerarquía hasta el objeto ThirdPersonController para hacerle su descendiente. 

16.- En la vista de proyectos seleccionamos el modelo “Girl”. En el inspector de 

propiedades pulsamos el botón “Rig”. En “Animation Type” cambiamos a “Humanoid”. 

Pulsamos “Apply”. 

17.- Seleccionamos el objeto “ThirdPersonController” en la vista de jerarquía. En el 

componente “Animator”, en la propiedad “Avatar” pulsamos el circulo a la derecha y 

seleccionamos con doble click “GirlAvatar” en la ventana que aparece. 

18.- Ejecutamos y comprobamos el funcionamiento de nuestro nuevo personaje. 

19.- Vamos a la vista de jerarquía y borramos el objeto Girl que cuelga de 

ThirdPersonController. 

20.- Creamos una carpeta en Assets llamada “Spiderman” y arrastramos en ella los 

archivos contenidos en la carpeta “Spiderman” de los recursos de la práctica. 

Seleccionamos el modelo Spiderman en la vista de proyecto. En el inspector de 

propiedades pulsamos el botón “Rig” en la parte superior. En “Animation Type” 

cambiamos a “Humanoid”. Pulsamos “Apply”. 

21.- Arrastramos el prefabricado Spiderman de la vista de proyectos a la escena. Lo 

ubicamos en (-3, 0, -2) con rotación en x de -90. 

22.- En la ficción Spiderman mide 1.78 m. Con ayuda del cubo unitario (lo hacemos visible 

y jugamos con su escala y su ubicación según el eje y) deducimos que la escala a aplicar al 

modelo en la vista de proyectos es de 0.51 aproximadamente. Se lo aplicamos. 

23.- En la vista de escena conseguimos una ubicación que nos permita tener un buen 

primer plano de la espalda y la cabeza de Spiderman. En la vista de proyectos 

seleccionamos el material Assets>Spiderman>Materials>spiderman_d. En el inspector de 

propiedades comprobamos que solo está asignada la textura en el apartado “Albedo”. 

Pulsamos el círculo a la izquierda de “Normal Map” y sin dejar de visualizar el modelo en la 

vista de escena seleccionamos en la ventana que aparece “Spiderman_n” y, después, 

pulsamos el botón “Fix Now” en el inspector. 

http://tf3dm.com/3d-model/puo-37663.html


24. Probamos el efecto al poner y quitar esta textura con información de normales. Para 

quitarla pulsamos en el círculo a la izquierda de “Normal Map” y seleccionamos “None”. Al 

final la dejamos puesta. 

25.- Repetimos los mismos pasos para asignar la textura denominada “Spiderman_s” a la 

propiedad “Metallic” de nuestro material. 

26.- En la jerarquía ponemos la rotación del objeto Spiderman según el eje X a 0. Lo 

arrastramos sobre el objeto ThirdPersonController. Seleccionamos ThirdPersonController y 

en sus propiedades asignamos como “Avatar” a “SpidermanAvatar”. 

27.- Ejecutamos la escena y movemos a nuestro personaje. 

28.- Creamos una carpeta de “Scripts” en la vista de proyectos. Arrastramos en ella el 

script “ThirdPersonOrbitCam” que se incluye en los recursos de la práctica. Seleccionamos 

la cámara en la vista de jerarquía y arrastramos el script “ThirdPersonOrbitCam” desde la 

vista de proyectos hasta la vista de inspector. 

29.- Con la “Main Camera” seleccionada en la jerarquía, localizamos la propiedad “Player” 

en el inspector, dentro del nuevo componente correspondiente al script. Arrastramos 

sobre esa propiedad nuestro ThirdPersonController. 

30.- Ejecutamos la escena. Ahora con las teclas cursoras podemos desplazar nuestro 

personaje y con el ratón podemos orbitar alrededor del mismo. 

31.- Vamos a una página Web como “tf3dm.com” o similar y descargamos algún modelo 

humano en formato .dae o .fbx. (p.e http://tf3dm.com/3d-model/puo-67895.html). El 

modelo debería estar preferiblemente “Rigged”. Probamos los pasos anteriores aplicados 

a este nuevo modelo. 

Chapter 4. The Furniture. 

32.- Ejecutamos Blender. (Se puede descargar gratuitamente de www.blender.org). 

Aparecerá por defecto un cubo. Si no existe lo creamos. (SHIFT + A) en la vista “3D View” y 

seleccionamos “Mesh>Cube”. 

33.- Ejecutamos el menú File>Save as… y seleccionamos la carpeta de Assets de nuestro 

proyecto de Unity. Nombramos el fichero como “sofa.blend”. 

34.- De vuelta a Unity vemos que el modelo ha aparecido en la vista de proyecto. 

Cambiamos su escala a 0.2 y pulsamos aplicar. Lo arrastramos a la escena y lo situamos en 

la posición (-1, 0.5, -3) respetando la rotación de -90 según el eje x. 

35.- Según vayamos modelando el objeto en Blender, podemos ir guardándolo y volviendo 

a Unity para ver su evolución. El refresco será automático. Volvemos a Blender. 

36.- Controles básicos de navegación en Blender: Botón central ratón = rotar vista. SHIFT + 

Botón central ratón = desplazar vista. Rueda del ratón = Zoom. Teclado numérico: [1, 7, 3] 

= [Front, Top, Right], [+, -] = Zoom, [5] = Cambiar vista perspectiva / ortográfica. 

37.- Seleccionamos vista frontal y perspectiva ortográfica (Teclado numérico 1 y 5). 

Seleccionamos modo “Edit Mode”. Visualización “Wireframe”. Manipulador de trasladar y 

tipo de selección vértice. 

http://tf3dm.com/3d-model/puo-67895.html
http://www.blender.org/


 

38.- Pulsamos la A para quitar la selección actual. Pulsamos B para activar la ventana de 

selección y seleccionamos todos los vértices. Arrastramos el manipulador del eje x (el rojo) 

hacia la izquierda, con la tecla CTRL pulsada para hacer “snap” hasta que el puntito naranja 

que define el centro de la figura quede justo en el lateral derecho del cubo. 

39.- Pulsamos la A para quitar la selección actual. Pulsamos B y seleccionamos los vértices 

de la parte superior. Desplazamos la parte superior con el CTRL pulsado hasta la mitad del 

cubo, es decir, la hacemos coincidir con la línea roja del eje x. 

 

 

 

 

 

40.- Pulsamos la A para quitar la selección actual. Pulsamos B y seleccionamos los vértices 

de la parte izquierda del rectángulo. Los desplazamos con el CTRL pulsado hacia la 

izquierda de forma que el rectángulo pase de tener un tamaño de 1x2 a 1x4 respecto a la 

rejilla de referencia. 

41.- Con los vértices de la izquierda seleccionados, pulsamos la tecla E para extruir. 

Movemos el cursor hacia la izquierda con la tecla CTRL pulsada hasta ganar un cuadrado 

más y hacemos click. 

 

 

 

42.- Pulsamos la A para quitar la selección actual. Pulsamos B y seleccionamos los vértices 

superiores del cuadrado que acabamos de crear. Pulsamos E para extruir hacia arriba dos 

cuadros de distancia (creamos un rectángulo de 1 x 2). 

43.- Extruimos hacia arriba un nuevo cuadrado unitario. 

44.- Pulsamos la A para quitar la selección actual. Pulsamos B y seleccionamos los vértices 

de la parte izquierda del cuadrado recién creado. Los extruimos hacia la izquierda otra 

unidad. 

 

 

 

 

 

 



 

45.- Establecemos una vista de la figura con el eje z hacia arriba, el eje y hacia abajo a la 

izquierda y el eje x hacia arriba a la derecha. Establecemos la visualización a “Solid” y el 

modo de selección a “Face”. 

46.- Con la tecla SHIFT pulsada vamos haciendo click con el botón DERECHO del ratón 

sobre todas las caras del lateral (tienen una forma de “s” con la base alargada). 

47.- Desplazamos esas caras dos unidades según el eje y, manteniendo la tecla CTRL 

pulsada para hacer “snap”. 

48.- Extruimos, pulsando la tecla E, todo el lateral que tenemos seleccionado una unidad 

más según el eje y con la tecla CTRL pulsada. 

 

 

 

 

 

 

49.- Giramos la figura arrastrando con el botón central del ratón hacia la derecha de forma 

que nos quede el eje z hacia arriba, el eje x hacia abajo a la izquierda y el eje y hacia abajo 

a la derecha. De la última parte que extruimos, seleccionamos las dos caras consecutivas 

que están en vertical (mirando hacia el eje x). 

50.- Pulsamos E y las extruimos moviendo el ratón y con la tecla CTRL pulsada hasta llegar 

al borde, en ese momento hacemos click con el ratón. 

 

 

 

 

 

 

 

51.- Pasamos a modo objeto. Pulsamos A para quitar la selección del objeto actual. 

Pulsamos SHIFT+A y creamos un nuevo objeto de tipo Mesh>Cube. 

52.- Pasamos a la vista frontal con la tecla 1 del teclado numérico. Establecemos la 

visualización a “Wireframe”. Intentamos establecer el nuevo cubo como un cojín del sofá, 

situado sobre su base, visto como un rectángulo horizontal de 1 x 4 unidades. Para ello 

utilizamos los manipuladores de movimiento y escala. En todo momento haremos snap 

con el CTRL y si es necesario simultáneamente también con el SHIFT.  



53.- Pasamos a la vista superior con la tecla 7 del teclado numérico. Redimensionamos el 

cojín para que ocupe toda la base del sofá (excluyendo respaldo y apoyabrazos). 

 

 

 

 

 

 

 

54.- Repitiendo los tres últimos pasos, creamos otro cojín formado por un paralelepípedo 

rectangular mediante un nuevo objeto Mesh>Cube. Le situaremos como respaldo del sofá, 

sobresaliendo una unidad por encima del mismo (más alto que la parte trasera del sofá). 

 

 

 

 

 

 

 

55.- En el editor “Outliner” que tiene forma de árbol conteniendo todos los objetos en 

nuestra escena, podemos hacer doble click en cada uno de los tres objetos creados y 

llamarlos “sofá”, “cojín inferior” y “cojín superior”. 

 

 

 

 

 

 

 

 

 

 



56.- En el editor “Outliner” pulsamos en los ojos para dejar solo visible el cojín inferior. 

Seleccionamos el objeto con el botón derecho. Entramos en “Edit mode” con vista 

“Wireframe” y selección de vértices. Seleccionamos con el botón derecho del ratón uno de 

los vértices de la cara que está situada en el centro del sofá (la que está al lado contrario 

del brazo del sofá según el eje x). 

57.- Con el vértice seleccionado pulsamos SHIFT+S y en el menú contextual que aparece 

seleccionamos: “Cursor to selected”. De esta forma ubicamos el cursor dentro del espacio 

tridimensional en el vértice. 

58.- Ahora pasamos a “Object mode” y localizamos la opción “Set Origin” en la pestaña 

“Tools” que está a la izquierda del editor. Seleccionamos en el desplegable “Origin to 3D 

Cursor”. Con esta operación conseguimos que el centro del objeto (representado por un 

puntito naranja) esté en un lateral. Esto nos va a permitir crear una imagen simétrica del 

objeto. 

59.- Repetimos la misma operación para el otro cojín. Seleccionando un vértice que se 

encuentre en la cara de “futura simetría” del cojín. 

 

 

 

 

 

 

60.- Seleccionamos el cojín inferior y en modo edición, con las teclas CTRL+R creamos seis 

lazos en el paralelepípedo, cercanos a las aristas y según los tres ejes. Esto servirá para 

poder suavizar los bordes posteriormente. 

61.- Repetimos la misma operación con el cojín superior. 

 

 

 

 

 

 

 

62.- Seleccionamos el objeto sofá en modo de edición,  vista “Wireframe” y selección de 

vértices. Pulsamos A para deseleccionar. Pulsamos B y seleccionamos todos los vértices. 

Pulsamos W y en el menú contextual que aparece seleccionamos “Remove Doubles”. Esto 

va a eliminar posibles vértices duplicados. 



63.- Con todos los vértices seleccionados, volvemos a pulsar W y en el menú contextual 

seleccionamos “Subdivide”. Después de ejecutar el comando, en el panel vertical de la 

izquierda del editor aparece el último comando aplicado “Subdivide”. Seleccionamos 

“Number of Cuts” = 2. 

 

 

 

 

 

 

 

64.- Con el sofá seleccionado, en el panel de propiedades, seleccionamos dentro de los 

iconos de arriba, el de “Object Modifiers” que tiene la imagen de una llave para tuercas. 

Pulsamos “Add Modifier” y seleccionamos “Mirror” (está en la mitad de la segunda 

columna “Generate”).  

65.- Añadimos otro modificador, en este caso “Subdivision Surface”. Esta el tercero por la 

cola en la segunda columna “Generate”. En este modificador podemos cambiar el número 

de “Subdivisions” poniendo en el campo “View” un 2. 

66.- Repetimos los mismos pasos para el cojín inferior y para el cojín superior. 

 

 

 

 

 

 

 

 

67.- Guardamos el modelo con File>Save. 

68.- Podemos volver a Unity3D y comprobar como luce nuestro sofá. Quizás requiera una 

reubicación dentro de la escena. 

69.- Nos queda aplicar materiales y texturas a nuestro modelo en Blender. Pero eso ya… 

será otro día. Si quieres ampliar información lo puedes hacer en la bibliografía propuesta al 

principio de la práctica, en las webs de Unity y Blender o en Internet. Ha sido un placer !!! 

The End 
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